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Chapter 1: Presentation of the MSS Composers 

MSS (Metabolism Study Summary) composers are satellite programs built to facilitate the creation and 

editing of metabolism study summaries.  

Three different MSS Composers are available. Depending on the type of metabolism study to be 

encoded, it is necessary to chose between the following ones:  

 

- MSS Composer (Plants) for metabolism studies carried out on primary crops; 

- MSS Composer (Crops) for metabolism studies carried out on rotational crops; 

- MSS Composer (Livestock) for metabolism studies carried out on animals. 

All MSS Composers are organised in a consistent manner: 

- a first level of tabs (Level 1) allows you to precise the type of plant or animal group used in the 

study. The MSS Composer automatically opens on the first tab (Crop 1 or Poultry); 

- a second level of tabs (Level 2) to encode data from the study such as the references, 

information about the protocol, results and conclusions.  
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Level 1:  

Plants  
(primary crops) 

In case metabolism is investigated for more than one plant in a single study, it is 
possible to add information for a second crop. All tabs from level 2 will have to 
be filled for the crops. If the study covers more than two crops, it might be 
necessary to create a second MSS file. 

Crops  
(rotational 
crops) 

Metabolism in rotational crops should be investigated in representative crops 
from the following crop groups: root and tuber, small grain and leafy vegetables 
(OECD n°502). 
As the protocol is usually the same for all three crops, the tabs I. General info, II. 
Materials and Methods, IV. Conclusions and VI. Attachments can only be filled for 
Crop 1. 

 
 

Animals As metabolism study can be carried out on poultry, lactating ruminants or other 
animals, it is important to select the appropriate tab before beginning the 
encoding: 

 

To be noted that the tabs in level 1 cannot be renamed in the current version (v.1.12).   
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Level 2 

As previously explained, all three MSS Composers are organised in a consistent manner. Data from a 

metabolism study are therefore populated in a similar logic. 

Briefly, the following information can be found in each section:  

I. General 
Info 

References of the study, guidelines used, if the study is GLP, abstract… 

II. Materials 
and 
Methods 

Chemical information on the active substance, radiolabel and physicochemical properties  

Information on the crops/animal used, the soil properties (for plant/rotational studies)… 

Information on the study design 

 

III. Results 
and 
Discussion 

Total Radioactive Residues measured in each matrix as well as in the different fractions during 
the extraction procedure 

Residues identified and proportion measured in each matrix 

 

IV. 
Conclusions 

Conclusions of the study 

V. Appendix Residues identified in tested matrices and metabolic scheme 

VI. 
Attachments 

Files in the following format can be attached in this section:  

.txt, .docx, .xlsx, .pdf, .xml, .pptx, .JPG 

Rules to fill-in the 6 sections are given Chapter 3.
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Chapter 2: Preliminary information and writing rules 
 

 Select the appropriate MSS Composer 

Please refer to the explanation in Chapter 1, Level 1. 

For livestock metabolism studies encode the study in the correct tab i.e. poultry, lactating ruminants 
or other animals.  
 

 Save your work  

Xml files are not automatically saved when closing the MSS Composers: 

- Click on "SAVE AS" to save your work as a .xml file.  

- Regularly save your work by clicking on the floppy disk icon. 

 

 How to name .xml files 

Please respect the following nomenclature when naming the .xml files: 

- Plant metabolism studies: StudyReference_activesubstance_p_crop_vX.xml  
(e.g.:  SREF123_1,3-dichloropropene_p_tomato_v1.xml 
  SREF987_amisdosulfuron_p_linseed_v2.xml) 

- Rotational crop metabolism studies: 
StudyReference_activesubstance_c_crop1_crop2_crop3_vX.xml 
(e.g.: SREF321_difenoconazole_c_wheat_mustard_turnip_v1.xml) 

- Livestock metabolism studies: StudyReference_activesubstance_l_species_vX.xml  
(e.g.: SREF456_amisulbrom_l_goat_v1.xml; SREF345_tolpyralate_l_hen_v2.xml) 

 

 Render function 

 

The Render function generates a Word file with all the encoded inputs. It can be a useful tool to 
copy/paste information directly into a report or in case you have to re-code a study into a new MSS 
Composer. 

Please note that if you encounter an anomaly while coding on the MSS Composer, the anomaly will be 
passed on to other MSS xml files if these are opened at the same time. In such a case, the RENDER 
function can also be interesting not to lose the information already encoded. 
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When .xml files and Word files are opened at the same time, there is no problem of anomaly's 
transmission. 
 

 Mandatory fields 

In the EFSA document “Reporting structured results of metabolism studies on rats, plants and livestock 
- Description of process steps of the information flow in EU”1, fields identified as mandatory are listed. 
Those fields have been highlighted in light green in the following section (Chapter 3: How to fill in the 
sections of the MSS composers?).  
 

 Writing rules 

The following writing rules are defined to insure the absence of encoding errors in the MSS Composers 
and a correct import of the .xml files into MetaPath.  

In addition, it is important to respect the defined nomenclature to allow a proper use of MetaPath 
various functions in the database (especially search queries, which are highly sensitive to the spelling). 

 For the sake of harmonisation, please respect the described rules. 

- Do not use slash “ / “  

- Use of N/A (na), N/D (nd) 

N/A stands for "Not Applicable". It is used to say that a criterion is not relevant. In the tab "Results and 
Discussion" B. and D., it describes that the information in a line (e.g. MeOH extraction) does not apply, 
i.e. a sample has not been extracted in this way, not been partitioned etc. NA could also be used for 
Not Available, synonym as not reported.  

N/D stands for "Not detected". It applies only to the tables of "Results and Discussion" when a 
compound has been searched for but not found. In case the report states the value of the LoQ or LoD, 
this value should be preferred (e.g. LoD 0.001). In case a metabolite cannot be found in a sample due 
to the label position, this compound should be deleted from the list. " - " should be used preferably 
over ND, as it increases readability in MetaPath. 

- Dash “ – “ 

A single dash "-" may stand for all of the above-mentioned acronyms. Its use must be accompanied by 
an explanation in the free-text field located above the different tables. 

- Writing of names with a capital letter 

Always begin with a capital letter to write chemical names, crops, crop groups, animals, 
species/breed/variety…  

- Writing of decimal numbers 

To enter decimal numbers, use the point "." and not the comma "," 

In case a unit is required, always begin with the number (dose rate, treatment level, growth stage…).  

 

                                                           
1 https://zenodo.org/record/4785179#.Yy2Me3ZBwdW 
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Chapter 3: How to fill in the sections of the MSS composers? 

I. General Info 

The section “General info” is completely common to the three MSS composers (plant, crops and 

livestock). This section provides general information on the study report such as references, identifiers, 

used guidelines... 

References: 

Click on "ADD" to fill in the field "References" – Right-click on Citation#1 to rename the reference with 

the number of the study report (E.g., Report No 1261W-1). 

You may have different reports for the same study (field report, analytical report, addendum…). For 

each report, you must add a reference because some parameters change from one study report to 

another (author, title for instance) – Each reference (Citation#) has to be renamed according to the 

corresponding report.  

 You must fill in I. General information for all references. 

 The others sections (II. Materials and Methods, III. Results and Discussion, IV. Conclusion,  

V. Appendix and VI. Attachments) are common to all references.  

For each reference, fill-in the following information: 

 Character limits + nomenclature 
→ information on how to fill in the field 

Example 

Author(s): 
Text, 1000 characters 

→ Same format as for a scientific paper  
Anonymous, X. and Author, N.  

Date:  
Drop-down menu  

→ Select month, day and year from the drop-
down lists 

September 7 2001 

Pages: Text, 20 characters  112  

Study Title: Text, 1 000 characters 
Distribution and metabolism 
of 14C-Bifenazate in grapes 

Reference Type:  
Text, no limit 

→ Fill in with the most available information as 
possible 

Company Report No.: XX-
000-NN; Study No.: ST0001 

Testing Laboratory: Text, 255 characters 
Research Center XN, Postal 
Code, Street, State, Country 

Company Study Number: Text, 250 characters 2022-0311 

Identifiers 

Use “Manage Ids” (Tool bar > Options) to create 
new Identifiers and EDIT to add them  

The procedure is described in Annex 1 
→ An Identifiers referring to the Company and/or 
the study can be added here   

 

 

  



MSS Composer: v.1.12  

 

9 
 

 
Character limits + nomenclature 

→ information on how to fill in the field 
Example 

Test Material: 

Text, 2 000 characters  
→ Common name of the active substance used in 
the study (same as in II Materials and Methods A. 
Material)  
+ if available: company experimental code in 
brackets  

bifenazate (D2341) 

Identifiers: 

Use “Manage Ids” (Tool bar > Options) to create 
new Identifiers and EDIT to add them  

The procedure is described in Annex 1 
→ Add the PARAM Code specific to the active 
substance (see more details in Appendix 1) 
→ A US EPA code (filled in by US EPA) can also be 
added 

PARAM Code:  
RF-0044-001-PPP 

   

Guidelines: 

Text, 5 000 characters 

→ Free field for additional information regarding 
guidelines 

OPPTS (OCSPP) 860.1300 
EU 7028/VI/95 
JMAFF 12Nohsan No.8147 
PMRA Chemistry Guidelines 
DIR98-02 Nature of the 
Residue 

   

GLP: 
Drop-down menu  
→ select yes or no 

yes 

 
Text, 5 000 characters 

→ Free field for additional information on GLP 
standards 

This study was conducted in 
accordance with EPA Good 

Laboratory Practice 
Standards, 40 CFR 160, 

effective October 16, 1989 
with the following 

exceptions…  
   

Acceptability: 
Drop-down menu  

→ select yes or no  
yes 

 
Text, 2 000 characters 

→ Free field for additional information regarding 
the study acceptability 

  

Evaluators:   

Evaluator Name 

Text, 100 characters 
→ Applicants should fill-in “Applicant” and 
Regulatory Authority should fill-in “Regulatory 
Authority” 

Applicant 
or 

Regulatory Authority Name 

Evaluator Affiliation 
Text, 250 characters 

→ Organisation supporting the application 

Applicant 
or 

Regulatory Authority 

 

BACKGROUND 
INFORMATION 

Text,  5 000 characters 
→ Free field for pertinent information on the 
active ingredient, its target mode of action, and 
the purpose of the end-use product 
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The two following fields do not exist in the Livestock MSS Composer:  

Product Type:  
Text, 250 characters 
→ Pesticide function 

acaricide 

Product Use:  
Text, 250 characters 

→ Intended crops 
grape, fruiting vegetables 

 
In all MSS Composers: 

EXECUTIVE SUMMARY 
Text, 20 000 characters 

→ Study summary or abstract 
Executive summary 

(abstract) of the study report 

 

II. Materials and Methods 

Information to report in this section, especially for subsection B. Study Design, depends on whether 

the study is carried out on plants or animals.  

A. MATERIALS 

1. Test Material 

This first section is common to all three MSS Composers. The following information should be reported: 

 Character limits + nomenclature 
→ information on how to fill in the field 

Example 

Common name 

Text, 192 characters 
→ Common name of the active substance (same common 
name reported in I. General Info) 
→ Begin the name with a CAPITAL letter  

Penthiopyrad 

IUPAC name 

Text, 2 000 characters  
→ Enter IUPAC Name – usually, it can be found in the List 
of EndPoints available in the Conclusion on the peer 
review of the pesticide risk assessment of the active 
substance (a.k.a. EFSA Conclusion) 

1-methyl-N-[2-(4-
methylpentan-2-

yl)thiophen-3-yl]-3-
(trifluoromethyl)pyrazole-

4-carboxamide 

CAS Chemical Name 

Text, 500 characters  
→ Enter CAS Chemical Name - usually, it can be found in 
the List of EndPoints available in the Conclusion on the 
peer review of the pesticide risk assessment of the active 
substance (a.k.a. EFSA Conclusion) 

N-[2-(1,3-dimethylbutyl)-
3-thienyl]-1-methyl-3-
(trifluoromethyl)-1H-

pyrazole-4-carboxamide 

CAS no. Valid CAS number 183675-82-3 

Company 
experimental name 

Text, 250 characters 
→ Same experimental name as the one reported in 
brackets in  I. General Info > Test Material  

MFT-753 

Other synonyms  
(if applicable) 

 Text, 5 000 characters 
→ Any other name(s) used in the study 

 If no information:  
NA   

Molecular Formula Text, 250 characters  C16H20F3N3OS 

Analytical Purity Text, 250 characters   98.5 % 

Impurities 
Text, 250 characters  

→ Enter the identity of the radiolabelled impurities 
present at significant levels (i.e., > 5%) 

  

Physical State Text, 250 characters   Liquid 

Stability Under Test 
Conditions 

Text, 250 characters  
→ Storage stability of the substance tested in the study  

1 year at < -20°C  
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Expiration Date 
Text, 20 characters  

→ Enter the date in the following format:  
“YYYY/MM/DD”, “YYYY/MM” or “YYYY”  

 March 2008 

 

Radiolabeled Test Material 

The structure of the tested substance and the position(s) of the radiolabeled test material must be 

defined here.  

Click on "ADD" to create/add a radiolabelled test material.  

 

 One radiolabelled test material has to be designed for each type of radiolabelled position 

(examples: 14C-Phenyl, 14C-Pyrazole, Cyclohexyl-UL-14C). 

 If a mixture of two radiolabelled test materials is applied on the same crop, every radiolabelled 

test material should be created separately (because information on specific activity and purity is 

specific for each radiolabelled molecule) - in addition to these two molecules, a third radiolabelled 

test material with the two radiolabelling site should also be created.  

 When creating the radiolabelled test items, you have to know how many matrices will be analysed 

in the study. Indeed, as only 10 columns are available in the results sections B and D, the radiolabelled 

material(s) has/have to be duplicated in order to add new columns and enter all the results. However, 

please keep in mind that the number of radiolabelled test items should be minimised. An additional 

radiolabelled material should be created only if necessary. As it is exactly the same as the first one, it 

should be named "[radiolabelled group]-common name#2" or "[radiolabelled group]-common 

name_2". 

Example: for animals, a low and a high dose can be tested. This requires duplicating the radiolabel 

material in order to differentiate the results according to the dose. In addition, total radioactive 

residues can be measured and further characterised in more than 10 matrices: urine, excreta, 

eggs/milk, blood, GI tract, fat (renal, omental, subcutaneous), muscles (breast/loin and flank), skin, 

kidney and liver. As a column cannot be added, the radiolabel must be duplicated. 

/!\ It is impossible to insert a radiolabelled test item between the ones that have already been drawn, 

so try to foresee the number of matrices. 

 For each radiolabelled material, right-click on "Radio-labeled #1" to rename the radiolabelled 

molecule following this nomenclature: [radiolabelled group]-common name.  
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The following information should then be filled-in for each radiolabelled test material created: 

 Character limits + nomenclature 
→ information on how to fill in the field 

Example 

Radiochemical purity: 
Value in percentage, without unit 

→ Report the exact number or a numeric range 
→ Less-than (<) and more-than (>) signs authorised 

98.7 

Specific activity as received: 
First cell: range of values or value  

→ Report the exact number or a numeric range 
Second cell: Unit (Text, 50 characters) 

4.11 MBq/mg 

Specific activity of dose: 
First cell: range of values or value  

→ Report the exact number or a numeric range 
Second cell: Unit (Text, 50 characters) 

1.85 MBq/mg 

Structure 

→ To draw the radiolabelled molecule with 2D Editor, click 

on the pen button " " 

→ Once you have drawn the first radiolabelled molecule, 
you can save time by copy and pasting the SMILES code of 
the first molecule to draw the second one. /!\ If you do 
so, don't forget to change the radiolabelling site (tip: to 
erase the radiolabelling, remove "{LBLXX}" from the 
SMILES code) 

→ For mixtures of isomers, the SMILES code of the 
different isomers should be separated by an underscore. 
Also, when available, please indicate the isomeric ratio of 

the applied substance using function “Ratio”  (last one) 
of 2D Editor. The ratio will be automatically included in the 
SMILES code. See below for illustration and some 
explanations on how to encode stereochemistry of 
molecules using SMILES code. 
 
Further information on the 2D Editor is provided in 
Annex 2 

[14C-pyrazole]-
penthiopyrad 
[14C-thienyl]-
penthiopyrad 

Mixture of py and 
th 

 

Table PhysChem Physicochemical Properties. 

 Character limits + nomenclature 
→ information on how to fill in the field 

Example 

Melting point/range 

Text, 250 characters  

 Fill-in at least columns "values" and 
"reference" 
 Add units when necessary 
 Column "Notes" can be filled in to specify the 
conditions (when available)  

 

pH  

Density  

Water solubility (_°C)  

Solvent solubility  
(mg/L at _°C) 

 

Vapour pressure at _°C  

Dissociation constant 
(pKa) 

 

Octanol/water partition 
coefficient Log(Kow) 

Notes: at 20°C, pH 5, 99.8% 
Value: 3.9 
Units: 
Reference: EFSA Journal 
2013;11(2):3111 
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 The next subsections are different depending on the type of MSS Composers for plants and 

rotational crops or MSS Composer for livestock: 

- For plants and rotational crops, the following subsections are intended to describe the test 

crops and the soil type of the study; 

- For livestock, they are intended to describe the general information on animals. 

 

For plants and rotational crops 

2. Test Crops  

Table B.7.1.1-1 (plants) / B.7.9-1. (rotation) Crop Information.  

 Character limits + nomenclature 
→ information on how to fill in the field 

Example 

Crop/Crop Group    

Primary crops  

Text, 250 characters 
→ Please respect the following nomenclature: Crop / Crop Group 
→ Crop / Crop Group has to begin with a capital letter and be 
written in the singular 
→ The Crop Group refers to one of these 5 crops groups: root 
vegetables, leafy crops, fruits, pulses and oilseeds, and cereals 
(OECD n°501) 
→ Repeat this step for every tested crop (one row per crop) 

Cabbage / Leafy 
crops 

Rotational crops  

Text, 250 characters 
→ Please respect the following nomenclature: Crop / Crop Group 
→ Crop / Crop Group has to begin with a capital letter and be 
written in the singular 
→ The Crop Group refers to one of these 3 rotational crop groups: 
root and tuber, small grain and leafy vegetable (OECD n°502) 
→ Specify rotational crop in brackets (rotation) - this will allow 

easily distinguishing between maps of primary and rotational crops 

once the MSS xml files are imported into MetaPath 

→ Repeat this step for every tested crop (one row per crop) 

Tomato (rotation) / 

Fruits and fruiting 

Variety 
Text, 250 characters 

→ Crop variety to be specified  
Dutch Round 

Cabbage 

Growth Stage at 
Application 

Text, 250 characters 
→ Expressed in BBCH stage 
→ Begin with the number followed by BBCH 
→ If no BBCH is reported in the study, for the sake of harmonisation 
please enter 0 : N/A  
or 0 : description of the stage (do not forget the space between 
the zero and the colon 
→ When a description of the growth stage(s) is available in the 
study report, it is also possible to translate it directly into BBCH 
stages using the BBCH scale 
(https://www.reterurale.it/downloads/BBCH_engl_2001.pdf) 

19 BBCH 
10 - 19 BBCH 

0 : N/A 

Growth stage at 
Harvest 

49 BBCH 
0 : maturity 

Harvest 
Commodities 

Text, 250 characters 
→ Parts of the plants harvested for residue analysis 

Outer leaves, heads, 
roots of cabbage 

Harvesting 
Procedure 

Text, 250 characters Manual 

 

https://www.reterurale.it/downloads/BBCH_engl_2001.pdf
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Test Site Type 

Drop-down menu  
→ Select the right item from the drop-down list. If nothing 
corresponds,  
→ Choose "other" and fill in the free-text field (max. 250 
characters) 
→ If another option than "other" is selected, you cannot write in 
the next box. 

greenhouse 

 

3. Soil Type  

Table B.7.1.1-2 (plants) / B.7.9-2 (rotation) Soil Physicochemical Properties.  

 Character limits + nomenclature 
→ information on how to fill in the field 

Example 

Soil Type 
mandatory for primary crop 
and rotational crops  

Text, 250 characters 
→ Specify the type of method in brackets  

sandy loam (USDA system) 

pH 

mandatory for rotational 
crops only 

 Text, 250 characters  
→ pH in water should be given. If another 
method was used, right-click on the column 
heading and specify the method in brackets 
→ Possible to indicate a single value or a range of 
values  

5.8-6.1 

OM % 

mandatory for rotational 
crops only 

Text, 250 characters 
→ Possible to indicate a single value or a range of 
values 
→ Do not indicate the units: they are 
automatically reported once the MSS xml file 
imported into MetaPath 

 

5.8 

Sand % 

mandatory for rotational 
crops only 

67.6 

Silt % 

mandatory for rotational 
crops only 

15 

Clay % 

mandatory for rotational 
crops only 

17.4 

Moisture Holding Capacity 
(at 1/3bar) 

mandatory for rotational 
crops only 

52.6  

CEC meq/100g 

mandatory for rotational 
crops only 

17.5 
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Environmental Conditions 

 Character limits + nomenclature 
→ information on how to fill in the field 

Example 

Temperature 

Text, 250 characters 

→ Available data on the field phase should be 

added here 

15.2-21°C and 7.0-14.7°C 

Rainfall at least 8mm in 5 days 

Lighting sunshine 0-12.8h/day 

Potential for 
Photodegradation of 
Substance 

  

 

For Livestock 

2. Animals  

Table B.7.2.1-1. General Test Animal Information 

 Character limits + nomenclature 
→ information on how to fill in the field 

Example 

Species 

Text, 250 characters 

→ Use only the common name, not the Latin 
name 
→ The name has to begin with a capital letter and 
be written in the singular 

Hen 
Goat 
Cow 
Fish 

Swine 

Breed 

Text, 250 characters 

→ The name has to begin with a capital letter and 

be written in the singular  

White Leghorn 

Age 

Text, 250 characters 

→ Begin with the number followed by the time 
unit (days/months/years) 
→ Possible to indicate a single value or a range of 
values  

66 weeks at study initiation 
1-5 years 

Weight at Study Initiation 
(kg) 

Text, 250 characters 

→ The study initiation corresponds to the day 0 
of the dosing period; acclimatation period should 
be excluded 
→ Possible to indicate a single value or a range of 
values  
→ Do not use the slash “/” because .xml file won’t 
be imported into MetaPath 

1.317-1.877 

Health Status 

Text, 250 characters 

→ Indication of the health status of animals during 
the study 

Healthy - no clinically 
abnormal signs observed 

Description of 
Housing/Holding Area 

Text, 250 characters 

→ Indication of the type of animal housing, 

light/dark cycle, % of humidity… 

individual laying cages 
within gas collection 

chambers, 14h light/10h 
dark cycle, ca. 20°C, ca. 35% 

humidity 

B. STUDY DESIGN 

This section totally depends on the type of MSS Composers for plants and rotational crops or MSS 

Composer for livestock. 
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For plants and rotational crops 

Experimental conditions 

Free-text field: briefly describe the experimental conditions (5000 characters). 

Table B.7.1.1-3 (plants) / B.7.9-3. (rotation) Use Pattern Information 

 Character limits + nomenclature 
→ information on how to fill in the field 

Example 

Chemical name 

Text, 250 characters 
→ Name of the applied molecule(s): report the 
same name as the common name indicated in A. 
Material/1. Test Material  
→ specify when it is a mixture 

Prothioconazole 
 

mixture of [14C-pyrazole]-
penthiopyrad and [14C-
thienyl]-penthiopyrad 

Application method Text, 250 characters 
Foliar spraying (hand-

operated sprayer) 
soil treatment (spraying) 

Application rate 

Text, 250 characters 
→ Specify the nominal dose rate with units 
→ Use a.s. as an abbreviation for "active 
substance" when stating the unit 
→ Additional row could be added for 
experimental dose rate 

200 g a.s./ha 

1000 g a.s./ha 

Number of applications Text, 250 characters 2 

Timing of applications 

Text, 250 characters 
→ Expressed in BBCH stage 
→ Begin with the number followed by the time 
unit (days/months/years) 
→ If no BBCH is reported in the study, please 
enter 0 : N/A or 0 : description of the stage (do 
not forget the space between the 0 and the colon 
“:”) 
→ When a description of the growth stage is 
available in the study report, it is also possible to 
translate it directly into BBCH stage using the 
BBCH scale (see the BBCH Monograph)   

65 BBCH 

PHI (Pre-Harvest Interval) 
for plants or PBI (Plant 
Back interval) for 
rotational crops 

Text, 250 characters 21 DA1A, 3 DALA 

 

Sampling 

Free-text field, 5000 characters 
→ Briefly describe how samples were taken, parts sampled, how samples were 
handled after harvesting (shipment, storage, etc.), and any preparation that 
was done prior to extraction  

 

 

https://www.reterurale.it/downloads/BBCH_engl_2001.pdf
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Extraction and Analysis 

Free-text field, 5000 characters 
→ Briefly describe extraction and analysis procedures (measure of total 
radioactive residues by combustion, different extraction procedures leading to 
several fractions, analytical method methods used to analyse the extracts)  

 

flowchart(s) of the extraction and fraction schemes 
 

→ Click on “ ” to add the flowchart of the extraction procedures of each 
matrix 
→ In “Description”, name the files according to the following nomenclature: 
“Extraction_matrix-name” 
→ Accepted format: .PDF, .PNG, .JPEG 

 

 

 

Identification and characterization 

Free-text field, 5000 characters 
→ Briefly describe here the procedures used to quantify, fractionate and purify 
the metabolites  

 

 

For Livestock 

Dose Regime 

 Character limits + nomenclature 
→ information on how to fill in the field 

Example 

Number of Animals per Dose 
Group 

Text, 20 characters 6 

Rationale for Selection of Dose 
Group 

 Text, 2 000 characters 
The laying hen was chosen as a 

typical poultry species used for egg 
production 

Analysis of Feed and Water 
 Text, 5 000 characters 

 

Food consumption was measured 
and recorded daily during 

acclimatisation and study periods - 
Periodic analysis of the mains water 

supply was undertaken.  

Table B.7.2.1-2. Test Animal Dietary Regime. 

 Character limits + nomenclature 
→ information on how to fill in the field 

Example 

Composition of Diet Text, 250 characters 
Standard commercially available 

non-medicated concentrate: 
Heritage Farmyard Layers Pellets 

Feed consumption (kg/day)  Text, 250 characters 0.3 kg/day (once daily) 
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Water Text, 250 characters 
Drinking water was available ad 

libitum throughout the study 

Acclimation period 

→ Indicate the duration of the acclimatation 
period number + days   
→ Begin with the number followed by the time 
unit (usually days) 
→ If a range of values is indicated, hyphens have 
to be bounded by space characters  

14 days 
6 – 8 days 

Predosing 
Text, 250 characters 

→ Indicate "Yes" or "No" 
No 

Table B.7.2.1-3. Test Animal Dosing Regime. 

 Character limits + nomenclature 
→ information on how to fill in the field 

Example 

Treatment Type 

Text, 250 characters 
→ Pre-filled by the software with "Oral": please 
change if different 
→ In case different radiolable positions are 
tested, create a line per position. Respect the 
following nomenclature: abbreviation of the 
radiolabelled test material_oral  
This will allow distinguishing lines when filling the 
field "Dose Regime" of Appendix 1 
 → If another parameter than the radiolabel 
differs, use this parameter to distinguish the 
treatment types 

py_oral 
ph_oral 

Treatment Level (mg/kg) 

Text, 250 characters 
→ Theoretical dose administered to animals 
→ Specify the unit for the sake of completeness: 
mg/kg DM or mg/kg bw/day 
→ If different treatment levels are tested in the 
study, create a line for each treatment level 

50 mg/kg DM 

Vehicle 

Text, 250 characters 
→ Pre-filled by the software ("capsule, feed, 
bolus, etc."): select or write down the correct 
information 

Gelatine capsule 

Parameters 
Text, 250 characters 

→ Pre-filled by the software ("Test material in 
vehicle"): please change if different 

Test material in vehicle 

Dosage Rate 

Text, 250 characters 
→ Experimental dose (nominal dose) 
administered to animals 
→ Specify the unit for the sake of completeness: 
mg/kg DM or mg/kg bw/day (use the same unit 
as in field "Treatment type" so that the rates can 
be more easily compared) 
→ If the administered dose is not the same 
between the radiolabelled test materials, create 
a line for each radiolabel 

66.6 mg/kg DM 

Timing/Duration 
 Text, 250 characters 

 
once daily / 14 days 

Timing from final dose to 
sacrifice 

 Text, 250 characters 
 

10 hours 
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Sampling 

Table B.7.2.1/2-4. Sample Collection Information 

 Character limits + nomenclature 
→ information on how to fill in the field 

Example 

Eggs / Milk Collected 
Text, 250 characters  

→ Indicate the frequency of daily collection 
Twice daily 

Number of Eggs / Amount of 
milk / Amount of … produced 
during normal production 

Text, 250 characters  
→ Indicate the daily production for one animal 

0.8 egg/day 

Excreta / Urine, Feces and Cage 
Wash Collected 

Text, 250 characters 
→ Indicate the frequency of daily collection 

Excreta: once daily / Cage wash: at 
sacrifice 

Interval From Last Dose to 
Sacrifice 

Text, 250 characters 
→ Begin with the number followed by the time 
unit (usually hours) 

10 hours 

Tissues Harvested and Analyzed 
Text, 250 characters 

→ Specify all fluids and tissues collected  

Liver, kidneys, peritoneal fat, 
subcutaneous fat with skin 

attached, combined leg and thigh 
muscle, breast muscle, GI tract and 

contents, blood, carcass, bile, 
partially formed eggs 

 

Free-text field, 5000 characters 
→ Briefly describe how samples were taken, parts sampled, how samples were 
handled after harvesting (shipment, storage, etc.), and any preparation that was 
done prior to extraction  

 

 

Extraction and Analysis 

Free-text field, 5000 characters 
→ Briefly describe extraction and analysis procedures (measure of total radioactive 
residues by combustion, different extraction procedures leading to several 
fractions, analytical method methods used to analyse the extracts)  

 

flowchart(s) of the extraction and fraction schemes 
 

→ Click on “ ” to add the flowchart of the extraction procedures of each matrix 
→ In “Description”, name the files according to the following nomenclature: 
“Extraction_matrix-name” 
→ Accepted format: .PDF, .PNG, .JPEG 
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Identification and characterization 

Free-text field, 5000 characters 
→ Briefly describe here the procedures used to quantify, fractionate and purify the 
metabolites  

 

 

III. Results and Discussion 

A. Total Radioactive Residues 

The fisrt part is common to the three MSS Composers and the second table depends on the type of 

MSS Composers for plants and rotational crops or MSS Composer for livestock. 

Extraction efficiency of radioactive residues from plant/livestock metabolism study using 

residue enforcement method 

 Character limits + nomenclature 
→ information on how to fill in the field 

Example 

Enforcement method 

Recovered equivalents (mg/kg) 

Text, 250 characters 

→ Possible to indicate a single value or a range 
of values 
→ Fill-in information regarding the method(s) 
used in the study and available in the report 

 

Overall extraction efficiency (%) Text, 250 characters 100% 

Defined residue (mg/kg) Text, 250 characters  

Defined residue extraction 
efficiency (%) 

Text, 250 characters 100% 

Extraction method used in the study 

Recovered equivalents (mg/kg) 

Text, 250 characters 

→ Possible to indicate a single value or a range 
of values 
→ Fill-in information regarding the method(s) 
used in the study and available in the report 

 

Overall extraction efficiency (%) Text, 250 characters 100% 

Defined residue (mg/kg) Text, 250 characters  

Defined residue extraction 
efficiency (%) 

Text, 250 characters 100% 

 

Quantitation 

Free-text field, 5 000 characters 
→ Briefly describe here the methods used for determining TRR values  
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For plants and rotational crops 

Table B.7.1.1-4 (plants) / B.7.9-4. (rotation) TRRs in Matrices. 

Column heading and column number are automatically adjusted according to the Radiolabeled Test 

Material(s) defined in section II. Materials and Methods / A. Materials. 

 Character limits + nomenclature 
→ information on how to fill in the field 

Example 

Matrix  

Text, 250 characters 

→ Insert as many lines as evaluated matrices 
→ Matrices should be named briefly but 
unambiguously: specify in the name of the matrix 
every parameter that is different from one matrix 
to the other (dose, part of studied vegetable, 
days after application...) 

outer leaves _200g 
heads_200g 

whole cabbage_200g  
outer leaves_1000g 

heads_1000g 
whole cabbage_1000g 

Timing and Application 

 Text, 250 characters 

→ Respect the following nomenclature:  

“application stage in BBCH, number of 

application(s) x dose rate in g a.s./ha” 

→ Separate the two information with a comma 

→ Start with a number and give the dose rate in 

g a.s./ha 

65 BBCH, 2 x 200 g a.s./ha 
65 BBCH, 2 x 1000 g a.s./ha 

Preharvest Interval (days) 

 Text, 250 characters 

→ Begin with the number followed by the time 
unit (usually days) 

21 days 

PBI (days) 

 for succeeding crops only 

Text, 250 characters 

→ Begin with the number followed by the time 

unit (usually DAT for days after treatment) 

30 DAT 
120 DAT 
365 DAT 

TRR% 
 Text, 250 characters 

→ Results obtained for each Radiolabeled Test 
Material should be filled in the corresponding 
column 

100.0 

ppm 0.475 

 

 For rotational crops, data on soil should be added if available. 
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Livestock 

Table B.7.2.1/2/3.-5. TRRs in Eggs/Milk, Tissue, and Excreta  

Column heading and column number are automatically adjusted according to the Radiolabeled Test 

Material(s) defined in section II. Materials and Methods / A. Materials. 

 Character limits + nomenclature 
→ information on how to fill in the field 

Example 

Matrix  

Text, 250 characters 
→ The table is pre-filled with Excreta / Urine, 
feces, Muscle, Fat, kidney, Liver, Milk/Eggs, GI 
tract, Other 
→ Use the right click to insert additional lines if 
necessary  
→ Insert as many lines as evaluated matrices 
→ Matrices should be named briefly but 
unambiguously: specify in the name of the 
matrix every parameter that is different from 
one matrix to the other.  

Muscle 
Fat 

Liver 
Kidney 
Excreta 

Cage wash 

[radiolabeled test material] → 
column header automatically 
filled in from II. Materials and 
Methods > A. Materials > 
Radiolabeled Test Material 

 Text, 250 characters 
→ Results obtained for each Radiolabeled Test 
Material should be filled in the corresponding 
column  

[phenyl-U-14C]-SYN545974 
[pyrazole-5-14C]-SYN545974 

% TRR 
 Text, 250 characters 

→ Results obtained for each Radiolabeled Test 
Material should be filled in the corresponding 
column 

87.73 

ppm 0.238 

TRRs 

TRRs in eggs 
TRRs in milk 
TRRs 

Drop-down menu 
→ Select did or did not 

→ Do not use the drop-down list if you do not know 

whether or not a plateau has been reached 

appear to have reached a plateau at the end 
of dosing (see Table 2.2.1-6) 

 

Table B.7.2.1/3/3.-6. TRRs in Eggs / TRRs in Milk / TRRs as Function of Time. 

Column heading and column number are automatically adjusted according to the Radiolabeled Test 

Material(s) defined in section II. Materials and Methods / A. Materials. 

 Character limits + nomenclature 
→ information on how to fill in the field 

Example 

Interval 

  Text, 250 characters 
→ Insert as many lines as there are interval times 
and rename them appropriately  
→ If available, also report data for faeces 
(poultry) and/or urine, excreta for lactating 
ruminants 
→ If data for several matrices are reported (urine, 
faeces, egg/milk), specify the matrix in the first 
line before adding the time interval 

Whole Egg 
Day 1 
Day 2 
Day 3 

 
Egg yolk 

Day 1 
Day 2 
Day 3 
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[radiolabeled test material] → 
column header automatically 
filled in from II. Materials and 
Methods > A. Materials > 
Radiolabeled Test Material 

 Text, 250 characters 
→ Results obtained for each Radiolabeled Test 
Material should be filled in the corresponding 
column  

[phenyl-U-14C]-SYN545974 
[pyrazole-5-14C]-SYN545974 

ppm   
Text, 250 characters 

→ Results obtained for each Radiolabeled Test 
Material should be filled in the corresponding 
column 

45 

% of dose 0.014 

Image attachment 

Image in .PDF, .JPEG or .PNG format can be attached here. 

 

General Health of Animals 

Free-text field: describe general health of the animals during the study 

Free-text field, 5 000 characters 
→ Briefly describe the general health of the animals during the study 

 

 

B. Extraction, Characterization, and Distribution of Residues 

This section is mandatory for all 3 MSS Composers. 

Table B.7.1.1-5. Distribution of the Parent and the Metabolites in Plant Matrices when 

dosed with 14C-Labelled. (Plants) 

Table B.7.9-5. Distribution of the Parent and the Metabolites in Rotational Crop Matrices 

when dosed with 14C-Labelled. (Rotation) 

Table B.7.2.1/2/3-7. Distribution of the Parent and the Metabolites in Poultry / Ruminant 

Matrices when dosed with 14C-Labelled. (Livestock) 

 

The table is the same for the 3 MSS Composers and the same filling rules apply: 

 The section begins with a free-text field: 

Free-text field, 5 000 characters 
→ Report table notes, explain abbreviations, etc… 
→ Footnotes in tables and free-text field are marked as (a), (b), etc.  
→ All abbreviations should be explained, e.g.:  
DALA: Days After Last Application  
PES: Post-Extraction Solid  
RRR: Residual Radioactive Residue  
–: not detected (if reported in Assessment Report, copy LODs)  
LOQ: Limit of quantification 
LOD: Limit of detection 
N/D: not detected 
N/A: not available 

 If residues were measured with several methods (HPLC and TLC for example), results for both 

methods should be reported and the corresponding method specified.  
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/!\ Pay attention to the number of columns required to report all the data available in the study (one 

column per matrix). If more than 10 columns are required, a second radiolabelled test item to get the 

extra columns has to be added (please refer to section II. Materials and Methods / A. Materials).  

/!\ If you need an additional table, try to order matrices rationally. 

 Column heading is filled in by default with automatic entries. Rename the headings “Matrix” 

appropriately: right-click on "Matrix X", rename the column and click on "OK".  

Matrices should be named briefly but unambiguously: specify in the name of the matrix every 

parameter that is different from one matrix to the other (part of studied vegetable, dose, days after 

application, ...). 

/!\ If a mixture of molecules has been applied, only fill in the subtab "Mixture of … and …". 

 To clear, delete or add rows: 

 To delete all rows of the table: right-click on the table and select "Clear table", 

 To delete a specific row: right-click on a cell of this row and select "Delete row", 

 To clear a specific row: right-click on a cell of this row and select "Clear row", 

 To add a row above/below the selected one: right-click on a cell of the row located 

below/above and select "Insert row above/below". 

 The following signs can be used: more-than (>) and less-than (<).  

/!\  If used, abbreviations or the sign “-“ must be described in the free-text field.  

/!\  Do not use “/”.  

C. Storage Stability of Residues 
 

Free-text field, 5 000 characters 
→ Briefly describe storage conditions, discuss whether or not residues are stable 
during storage 

 

 

Table B.7.2.1/2/3-8 Summary of Storage Conditions. 

 Character limits + nomenclature 
→ information on how to fill in the field 

Example 

Matrix (RAC or Extract) 

Text, 250 characters 

→ Report the available data from the study 
report 

Seed 

PBI (days) 

 for rotational crops only 

30 DAT 
120 DAT 
365 DAT 

Storage Temperature °C -20°C 

Actual Storage Duration (Days 
or Months) 

2 months 

Interval of Demonstrated 
Storage Stability [specify 
crop/matrix if different] 
(days/months) 

 for plants and livestock 

  

Limit of Demonstrated Storage 
Stability   
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 for rotational crops only 

 

D. Identity of Residues in Crop / Rotational Crop / Poultry / Ruminant / Other 

Animals 

This section is mandatory for all 3 MSS Composers. 

Table B.7.1.1-5. Summary of Characterisation and Identification of Radioactive Residues in 

Plant Matrices Following Application of Radio-Labeled #1. (Plants) 

Table B.7.9-7. Summary of Characterisation and Identification of Radioactive Residues in 

Rotational Crops Matrices Following Application of Radio-Labeled #1. (Rotation) 

Table B.7.2.1/2/3-9. Summary of Characterisation and Identification of Radioactive 

Residues in Poultry / Ruminant Matrices Following Application of Radio-Labeled #1. 

(Livestock) 

 

The table is the same for the 3 MSS Composers and the same rules described in III.B Extraction, 

Characterization, and Distribution of Residues apply : 

 The section begins with a free-text field: 

Free-text field, 5 000 characters 
→ Report table notes, explain abbreviations, etc… 
→ Footnotes in tables and free-text field are marked as (a), (b), etc.  
→ All abbreviations should be explained, e.g.:  
DALA: Days After Last Application  
PES: Post-Extraction Solid  
RRR: Residual Radioactive Residue  
–: not detected (if reported in Assessment Report, copy LODs)  
LOQ: Limit of quantification 
LOD: Limit of detection 
N/D: not detected 
N/A: not available 

E. Proposed Metabolic Pathway 

Metabolic Map 

In this section, a metabolic map can be built once section V. Appendix 2 has been filled in. 

 To build the metabolic map, go to HOME > Tools and click on "Build Metabolic Map". The Map is 

automatically generated. 
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Free-text field 

In the free-text field below the map, briefly describe the metabolic pathway and reactions (oxidation, 

hydrolysis, etc.). 

Free-text field, 5 000 characters 
→ briefly describe the metabolic pathway and reactions (oxidation, hydrolysis, etc.) 

 

Table B.7.2.1-10. Identification of Compounds from Metabolism Study (both proposed and 

found) 

This table is automatically filled in from section V. Appendix > Appendix 2. 

 

IV. Conclusions 
 

CONCLUSIONS 

Free-text field: briefly present the conclusions of the study 

Free-text field 

→ Briefly present the conclusions of the study. You can copy here the conclusions of the study report. 

 

REFERENCES 

Free-text field 
→ Indicate here references to other metabolism studies (if applicable). 
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V. Appendix 
 
The filling of appendices 1 and 2 is mandatory. It is required so that the xml file can be imported into 
MetaPath. 

Appendix 3 is automatically filled in using information available in Appendix 1 and Appendix 2. 

The following information can be found in each Appendix: 

Appendix 1 All matrices analysed and treatment conditions of the experiment 

Matrices reported must be compliant with section III. Results and Discussion,  
B. Extraction, Characterization, and Distribution of Residues and D. Identity of residues in 
Crop 

Appendix 2 Identified compounds 

 Identified compounds reported are compliant with section III. Results and Discussion, 
D. Identity of Residues. Identified compounds and matrices in which they are detected 
should be linked. 

Appendix 3 Links between matrices reported in Appendix 1 and identified compounds described in 
Appendix 2  

 Automatically completed following the filling of Appendices 1 and 2 

Appendix 1 

Completing Appendix 1 is mandatory. 

 Report all matrices for which attempts are made to characterise and/or identify residues (parents 

and metabolites). Matrices reported should be compliant with section III. Results and Discussion, B. 

Extraction, Characterization, and Distribution of Residues and D. Identity of residues in Crop. 

 Report all matrices for each radiolabelled test material. Bear in mind that there can be differences 

from one radiolabelled test item to the other. 

 In case no residues are identified in any matrices (for example because TRR were too low), 

Appendix 1 must be completed. Add at least 1 matrix. 

 

How to procede: 

Click on 
 

to add a new matrix (row). 

Click on 
 

to insert a matrix (row) between two existing ones - the new row is inserted below the 
selected one. 

The icon 
 

to remove a matrix. 

Click on 
 

to modify a row. It can also be achieved by double-clicking on a cell of the row. 
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For plants and rotational crops 

 Character limits + nomenclature 
→ information on how to fill in the field 

Example 

Test# 

Text, 100 characters 

→ Matrices should be named briefly but 
unambiguously so that they can be easily 
distinguished 
1. first letters of the labelling (mandatory)  
2. portion analysed (mandatory)  
3. dose applied (optional)  
4. PHI/PBI (optional)  
… 
→ Every information should be separated from the 
next with an underscore “_” 

ph+py_forage_200g_30DAA 
ph+py_forage_200g_120DAA 
 
ph+py_hay_100g_30DAA 
ph+py_hay_100g_120DAA 

Number 
Number 

→ Number of plants by radiolabelled test material 
9 

Application Method  Text, 50 characters  soil spraying 

Application Rate 

 Dose and unit 
→ Specify the dose rate and the unit 
→ Make sure the same unit is used in all sections 
(for the sake of homogeneity) 

→ Separated the value from the unit by a space 
→ Use a.s. as an abbreviation for "active 

substance" when stating the unit  

408.6 g a.s./ha 

Number of Applications Value 1 

Timing of Applications  

Number 
→ Start with a figure followed by a space. 
If no information is available regarding timing of 
applications, the field should be filled in with 0 : 
NA or 0 : description of the stage (do not forget 
the space between the zero and the colon) 

00 BBCH - bare soil 

Plants: PHI 
Rotational Crops: PBI 

Text, 250 characters 

→ Separated the value from the unit by a space 
30 days 

Matrix Text, 192 characters  Wheat hay 

Experimental Descriptor Text, 192 characters    

Remarks 

Text, 32 760 characters 
→ Free-text field. It can be used to explain terms 
and abbreviations which are used for naming 
"Test#" or give some additional information about 
the study 

DAA = Days After 
ApplicationActive substance 
applied as a mixture of two 

radiolabelled test items 

Citation 
Drop-down menu 

→ select corresponding citation 
  

Radiolabeled Test Material 
Drop-down menu 

→ select corresponding radiolabelled test material 
Mixture of ph and py 

Test Crop (from Table 1) 
Drop-down menu 

→ select the corresponding test crop 

Tomato (rotation) / Fruiting 
vegetables 

Soil type (from Table 2) 
Drop-down menu 

→ select the corresponding soil type 
Sandy loam 
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For Livestock 

 Nomenclature Example 

Test# 

Text, 100 characters 

→ Matrices should be named briefly but 
unambiguously so that they can be easily 
distinguished 
1. first letters of the labelling (mandatory) 
2. animal species (mandatory) 
3. tissue analysed (mandatory) 
4. dose applied (optional) 
… 
→ Every information should be separated from 
the next with an underscore “_” 

ph_hen_liver 
ph_hen_egg yolk 

ph_hen_egg white 
ph_hen_muscle 

ph_hen_fat 
py_hen_liver 

py_hen_egg yolk 
…  

Gender 
Multiple choice 

→ Select "Male", "Female" or "Not Reported" 
Female 

Number 
Number 

→ Number of animals dosed with a given 
radiolabelled test material 

6 

Dose Route 

Text, 192 characters 
→ Route of administration, path by which the 
radiolabelled test item is taken into the animal 
body (= treatment type) 

Oral 

Dose Nominal 

Exact number 
→ Theoretical dose administered to animals 
→ Unit can be modified - for the sake of 
completeness, please specify "mg/kg DM" or 
"mg/kg bw/day" 
→ To avoid the use of “/” between two values . 
The tange of values should be presented as 22.4 
- 23.2 instead of 22.4/23.2 mg/kg DM  

50 mg/kg DM 

Dose Measured 

Number 
→ Experimental dose administered to animals 
→ Unit can be modified - for the sake of 
completeness, please specify "mg/kg DM" or 
"mg/kg bw/day" 
→ To avoid the use of “/” between two values . 
The range of values should be presented as 22.4-
23.2 instead of 22.4/23.2 mg/kg DM 

66.6 mg/kg DM 

Matrix 
Text, 192 characters 
→ Analysed tissues 

Liver 

Test Duration 

Number 
→ Duration of the study 
→ Units can be modified - for the sake of 
completeness, please specify "days"  

14 days 

Experimental Descriptor  Text, 192 characters  

Dose Type 

Multiple choice 

→ Select "Single" or "Multiple" 
→ clarify if available "on every …… for….." 

Multiple 
On every 24 hours for 14 days 

Remarks 

Text, 32 760 characters 
→ This free-text field can be used to explain 
terms and abbreviations which are used for 
naming "Test#" or give some additional 
information about the study 
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Citation 

Drop-down menu 
→ Select the corresponding citation (according to 
the radiolabelled test material or the 
administered dose) 

 

Radiolabeled Test Material 
(RLTM) 

Drop-down menu 
→ Select the corresponding radiolabelled test 
material 

 

Animal Information (from Table 
1) 

Drop-down menu 
→ Select corresponding to animal information 

 

Dietary Regime (from Table 2) 
Drop-down menu 

→ Select the corresponding animal’s dietary 
regime during the study 

 

Dosing Regime (from Table 3) 
Drop-down menu 

→ Select the corresponding dosing regime 
 

Sampling Information (from 
Table 4) 

Drop-down menu 
→ Select the corresponding sampling regime 

 

Appendix 2 

Completing Appendix 2 is mandatory. 

 Report all metabolites identified in section III. Results and Discussion, D. Identity of Residues.  

 In case no residues are identified in any matrices (for example, because TRRs were too low), report 

at least the parent. 

The same functions as in Appendix 1 are available and the same rules apply.  

 

 ALWAYS begin with the parent compound and carry on with metabolites. 

Time-saving tips:  

 Molecules can be drawn by copying and pasting the SMILES code of a close one that has already 

been encoded and then modifying it using the drawing tools.  

 Build Appendix 2 following parent compound's degradation. This will help not losing the thread. 

 

 Character limits + nomenclature 
→ information on how to fill in the field 

Example 

Common Name/Code  

→ common name / company experimental 
name  
→ The same common name of the active 
substance and company experimental code 
should be reported as in I. General Info > Test 

Material and in II. Materials and Methods > A. 

Materials 

Pydiflumetofen / SYN545974 
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 Character limits + nomenclature 
→ information on how to fill in the field 

Example 

→ Separate common name and experimental 
code with “space / space”   

Chemical Name 

→ Common name used in the study report with 
the company experimental name in brackets  

/!\ Do not write down the full chemical name of 
the molecules (using common names of the 
molecules helps reading the results of MetaPath 
functions such as "Search chemical" and '"Search 
similarity") 

Pydiflumetofen (SYN545974) 

Chemical Structure 

→ To draw a molecule, clik on  to open the 
2D Editor and draw the molecule or copy and 
paste the smile code. 
→ Please refer to Annex 2 for the complete 
procedure.  

 

Parents 

→ Describe the relationship(s) between 
compounds by ticking the box(es) that 
correspond(s) to the compound(s) from which 
the metabolite can be generated.  
→ Relationships should be specified for all 
metabolites, except for the parent compound. 

The metabolic pathway is built based on the 
information encoded in this field.  

 

Treatment Groups 

→ Tick the box(es) that correspond(s) to the 
matrix(ces) in which the compound has been 
identified.  
This section must be compliant with the results 
reported in III. Results and Discussion > D. 

Identity of Residue in Crops. 

 

Expertise 

→ If there is no issue drawing the compound, 
select "None" 
 
→ If uncertainties were identified for the 
compound while drawing it, select “Expertly 
specified” and specify in “Decision” which 
assumptions were made when drawing the 
compound (e.g.: unknown site of conjugation). 
In Expert, specify Applicant or Regulatory 
Authority.  
 
→ If issues were identified for the compound, 
select “Expertly specified”and specify 

o Assumed by author(s) for a compound that 
was not identified in the study but assumed as 
an intermediate 

o Residue of Concern for an active ingredient 
and its degradates for which risk is assessed, 
based on known or assumed toxicological and 
exposure concerns. A general rule used for 
present metabolites greater than 10%, but 
consideration is given to all metabolites 
exhibiting toxicity greater than parent. 
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 Character limits + nomenclature 
→ information on how to fill in the field 

Example 

o Tolerance when a maximum residue level of a 
pesticide (usually measured in parts per million, 
ppm) that can legally be present in food or feed 
is defined as the result of a pesticide application  

 

Additional indications: 

- If the position of the conjugate is not determined or if a mixture of compounds is identified 

 Draw the most logical arrangement and write in field Expertly specified > Decision: “Unknown 

position of the [type of conjugation] conjugation” (because the position of glucuronide is hypothetical 

and must be notified) or “Mixture of compounds: various conjugates of [name of the conjugated 

compound]”.  

- If, according to the study report, only one peak (HPLC) was assigned to two different 

compounds 

E.g.: “one further peak was assigned to the metabolites M700F008 and M700F006 (0.111 mg/kg or 

4.0 % TRR)”  

 Draw every compound individually and connect them both with their parent compound. 

 

- How to link isomer structures and their parent compounds 

 When a molecule (A1) and its isomer (A2: molecule A with a hydroxylation undetermined on the 

alkyl chain) have been identified, you have to draw the two structures. However, if the exact position 

of the hydroxylation has not been determined, complete as follow the Expertise section of the 

Appendix2 Editor:  

 

 

 If another molecule (B) coming from molecule A1 is identified (B corresponds to molecule A, A 

having an undetermined hydroxylation on the alkyl chain so that there are two A isomers), we would 

recommend linking B to the two isomers because, as the two hydroxylations are not determined, B 

could come from both molecules.  

Appendix 3 

This table is filled in automatically using the information available in Appendices 1 and 2.  
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You can link and unlink matrices and compounds by right-clicking the cells. This can also be done by 

scrolling /!\ but it is very sensitive.  

Consequently, we strongly recommend updating this table using the "Treatment group" fields of 

Appendix 2. 

 

Additional indications on the linking of compounds and matrices: 

Example of a study on the metabolism of fluxapyroxad in soybean 

“It is proposed that BAS 700 F is metabolised in soybean by the following transformation reactions: N-

demethylation of the pyrazole moiety and hydroxylation of the biphenyl moiety. Both reactions, 

combinations there of, and subsequent O- and N-conjugation reactions (glucose and/or, malonic acid) 

result in a range of related compounds” 

- When it is not clear in which matrices the different compounds were identified but they 

appear in the metabolic pathway and are quoted in the conclusion of the study  

 Only draw conjugates in Appendix 2 and do not specify in which matrices they could have been 
identified (the rows corresponding to these metabolites are left empty in Appendix 3).  

Conjugated compounds will appear in the metabolic map without being highlighted by function (see 

button  in the MetaPath software). 

 

VI. Attachments 

Attachments 

Any file type (e.g. chromatograms, flow charts, study reports, addendum…) can be added to the MSS 

composer. The attachment will also be available when the xml file will be imported to the MetaPath 

database.  

 Use the following buttons: to attach a file:  

 

 In “Description”, rename the file according to its nature (study report XXX, addendum number X, 

metabolism pathway for the active substance XXX, flow chart of XXX…). 

 Files in the following format can be attached in this section: .txt, .docx, .xlsx, .pdf, .xml, .pptx, .JPG. 
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ANNEXES 
 

Annex 1 – Regulatory IDs in the MSS Composers 
 

1. The Regulatory ID library  

The three MSS Composers share a common library of Regulatory IDs. It comes prepopulated with the 

following IDs:  

ID  Agency  Description  

MRID  US EPA  Master Record Identification Number  

PMRA  Health Canada  Pest Management Regulatory Agency  

PC Code  US EPA  Pesticide Chemical Code  

Other    Placeholder ID, kept for backward compatibility  

 

The library can be viewed and edited in the Regulatory ID manager, accessible from the Manage IDs 

button on the Options tab of the Composer ribbon:  

 

This brings up the following editor:  

 

  



MSS Composer: v.1.12  

 

35 
 

The top list contains all of the available identifiers. Clicking on an identifier displays its properties in 

the panel below. Each ID has a caption, agency and description. The Show in Citations and Show in 

General info checkboxes determine whether a particular ID would appear in the corresponding section 

of the Composer.  

● To edit an identifier, the user needs to select it from the list, then make the changes to the properties 

and finally click on the Update button.  

● To delete an identifier from the library, the user needs to select it and to click on the Delete button.  

● Adding a new identifier is done by first filling in the properties and then clicking on the Add button. 

There cannot be two IDs with the same Caption and Agency.  

Clicking on the OK button saves the made changes to the library and all of the current codes become 

available in all of the Composers.  

This editor only manages the properties of the identifiers and does not change the values that the 

users enter in each section of the composer. Entering of values is described in the next section.  

 To create the PARAM Code: 

- Go in “OPTIONS” > Manage Ids 

 

- Enter the following information for the PARAM Code: 
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- Press the button Add and the OK to save the created PARAM Code in the MSS Composer 

 

- PARAM Code has to be created in all three MSS Composers. 

 The PARAM Code can be found and downloaded from the EFSA catalogue browser available on 

Zenodo: European Food Safety Authority. (2020). Harmonized terminology for scientific research: 

https://zenodo.org/record/3243215#.YJU5LbUzbD4  

2. Regulatory IDs in References (citations)  

In the references section of the Composers (I. General Info), each entry may have a different set of 

identifier-value pairs. The entered IDs are displayed in the identifiers panel. 

To add an identifier or modify an existing value, click on the EDIT button: 

 

This brings up the Regulatory ID editor:  

https://zenodo.org/record/3243215#.YJU5LbUzbD4
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The left section of the editor shows all the identifiers currently available in the ID library. Managing 

this library was explained in the previous section.  

Clicking on an identifier in the list on the left selects it. Its properties (Caption, Agency, Description) are 

then displayed to the right.   

The grid on the right side of the window displays identifier-value pairs that have already been entered 

in this section. Existing values can be edited directly in the text box.  

To add a new identifier entry in the current section, the user needs to select it from the list on the left 

side and then click on the arrow pointing right (>). This makes a new entry in the grid on the left, with 

the value field empty. The user can fill in the value field directly in the text box. 

To delete an id-value pair, first select it by clicking on the Identifier entry in the grid on the left. The 

left arrow (<) button then removes the entry.  

Clicking on the OK button updates the entries in the Identifier panel.  

3. Regulatory IDs in General Info (related to the chemical compound)  

Similar to the references section, identifier codes can be added and edited in the General Info section. 

Clicking on the EDIT button brings up the editor explained in the previous section.  

 

 To add the PARAM Code: 

- Click on the PARAM Code in the list of the Available Identifiers; 
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- Click then on the arrow icone (>) in the middle of the window (the Identifier will swich from 

the left screen to the right screen); 

- Tip in the appropriate PARAM Code in the right screen; 

- Press OK to save the changes. 

 

The PARAM Code is now visible in the MSS Composer: 
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Annex 2 – Drawing compounds with the 2D Editor 

The 2D Editor is a tool allowing you to draw compounds. It can be opened by clicking on the “pen 

button”  in section II. Materials and Methods > A. Material (Radiolabeled Test Material) and 

section V. Appendix > Appendix 2.  
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This brings up the Regulatory 2D Editor:  

To draw a molecule 

Option 1: Smile code available: 

- Open the 2D Editor using the “pen button”,  

- Copy/paste the smile code in the appropriate field, 

- Check that the structure of the compound is correct, 

- Click on OK to save the molecule structure and close the window. 

 

Option 2: Smile code not available: 

The compound has to be drawn using the 2D Editor: 
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 What you can find in the toolbar: 

 
UnDo/ ReDo  

 
Clear the canvas 

 
Hide / show heavy atoms 

 
Hide / show hydrogen atoms 

 
Show atom number 

 
Flip the structure 

 
Change the texte format in the drawing field 

 
Drag the mouse to create a bound 

 
Select the type of bound 

 
Select the icon and then click on the white field to draw the atom 

 Select the kind of atom 

 
Select atom from the periodic table 

 Set a positive or negative charge 

 Move the drawn molecule in the white field   

 
Select / Move / Rotate / Zoom  

 
Cut a bounds and/or remove atoms (clearing function) 

 
Insert a benzen ring 

 Add an explicit hydrogen 

 Remove an already defined explicit hydrogen 

 
Indicate the isomeric ratio of the applied substance 

 

How to deal with a mixture of isomers? 
For a mixture of isomers, the SMILES code of the different isomers should be separated by an 

underscore. Also, when available, please indicate the isomeric ratio of the applied substance using the 

function “Ratio”  (last one) of 2D Editor. The ratio will be automatically included in the SMILES code. 

See below for illustration and some explanations on how to encode stereochemistry of molecules using 

SMILES code. 
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Encoding stereochemistry of molecules in 2D Editor 
 

(Main source: https://www.daylight.com/meetings/summerschool98/course/dave/smiles-intro.html) 
 

Specifying double-bond configuration 

Configuration around double bonds is specified in SMILES by the characters `/' and `\’ that are 

"directional bonds" and can be thought of as kinds of single bonds. These symbols indicate relative 

directionality between the connected atoms and have meaning only when they occur on both atoms 

that are double bonded. 

SMILES code Picture of the molecule Remarks 

OC/C=C/Cl or OC\C=C\Cl 

 

Cl and CH2OH are on 
"opposite sides" of the 
double bond. 

OC/C=C\Cl or OC\C=C/Cl 

 

Cl and CH2OH are on the 
"same side" of the 
double bond. 

OC/C=C/Cl_OC/C=C\Cl 

 

Mixture – SMILES code 
of the two molecules 
linked by an underscore 
(_) 

 

Specifying tetrahedral chirality 

SMILES uses a very general type of chirality specification based on local chirality and symmetry point 

groups. Instead of using a rule-based numbering scheme to order neighbouring atoms of a chiral 

centre, orientations are based on the order in which atoms occur in the SMILES string.  

https://www.daylight.com/meetings/summerschool98/course/dave/smiles-intro.html
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In SMILES, tetrahedral centres may be indicated by a simplified chiral specification (@ or @@ / {P+} or 

{P-}) written as an atomic property following the atomic symbol of the chiral atom. If a chiral 

specification is not present for a chiral atom, the chirality of that atom is implicitly not specified. 

Looking at the chiral centre from the direction of the "from" atom (as per atom order in SMILES), @ or 

{P+} means "the other three atoms are listed anti-clockwise; @@ or {P-} means clockwise. If all atoms 

are explicitly specified in SMILES, e.g., N[C@](C)(F)C(=O)O/ NC{P+}(C)(F)C(=O)O, the order of the atoms 

should be clear, i.e., N is the "from" atom, and the other atoms are anticlockwise in SMILES order 

(methyl, fluoro, carboxyl): 

 

If the chiral atom is the very first atom in the SMILES, e.g., [C@](F)(N)(C)CC, the first-appearing 

neighbour is taken to be the "from" atom. 

If the chiral atom has a non-explicit hydrogen, (it can have at most one and still be chiral) it will be 

listed inside the chiral atom's brackets when using @/@@, e.g., F[C@H](N)C, but it can be omitted 

when using {P+}/{P-}, e.g., FC{P+}(N)C. The order of the non-explicit hydrogen is exactly as written in 

SMILES, i.e., in this case, the first of the three following atoms (H,N,C). Similarly, if a chiral atom has a 

ring closure, e.g., N1CCCO[C@H]1CC / N1CCCOC{P+}1CC, the O is the from atom, and three following 

atoms are in the order they are connected to the chiral centre as written in SMILES, i.e., H (immediately 

following the symbol), then N (the ring closure is next), then the ethyl carbon. 

To reiterate, the implied chiral order is always exactly as written in SMILES. 

SMILES code Picture of the molecule Remarks 

N[C@](C)(F)C(=O)O or 

NC{P+}(C)(F)C(=O)O 

 

From N: (methyl, F, 
carboxyl) appear anti-
clockwise. 

N[C@@](C)(F)C(=O)O or  

NC{P-}(C)(F)C(=O)O 

 

From N: (methyl, F, 
carboxyl) appear 
clockwise. 

N[C@@H](C)C(=O)O or 

NC{P-}(C)C(=O)O 

 

From N: (H, methyl, 
carboxyl) appear 
clockwise. 

N[C@H](C)C(=O)O or 

NC{P+}(C)C(=O)O 

 

From N: (H, methyl, 
carboxyl) appear anti-
clockwise. 
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Further information on how to draw molecules can be found in:  

https://www.efsa.europa.eu/fr/applications/pesticides/tools  

https://www.efsa.europa.eu/fr/applications/pesticides/tools
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Annex 3 – Examples of conjugated forms 
Unconjugated Conjugated Source 

CGA353968 

 

CGA 353968-N-Sugar conjugate 

 

T
h

iam
eth

o
x

am
 (to

b
acco

, lettu
ce) 

CGA 353968-O-Glucose conjugate 

 

CGA 355190 

 

CGA 355190-S-Glucose conjugate 

 

CH3

NH

O

NH

N
Cl

S

CH3

N OH

OH

OHHO

O

O

NH

N

Cl

S
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CGA 349208 

 

CGA 349208-O-Glucose conjugate 

 

 

SYN547891 

 

SYN547891-N-Glucuronide conjugate 

 

P
y

d
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m
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fen
 (p
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u

ltry
) 

SYN548264 

 

SYN548264-O-Glucuronide conjugate (O-

GlcA) 

 

P
y
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m
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fen
 (g

o
at) 
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753-A-OH 

 

753-A-OH O-malonyl glucose conjugate 

 

P
en
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 (cab
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e) 

DM-753-A-OH 

 

DM-753-A-OH O-glucose conjugate (O-Glc) 
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753-T-DO 

 

Cys-T-DO 
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M700F008 

 

M700F052 (O-glucose and acid malonic 

conjugation) 

 

 

F
lu

x
ap

y
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x
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 (so
y

b
ean

) 

M700F074 

 

M700F131 (O-glucose and feruloyl 

conjugation) 

 

F
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 (w
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eat) 

 



MSS Composer: v.1.12  

 

49 
 

Annex 4 – Common error messages when importing MSS xml files into MetaPath 

Error message Solution 

X no screenshot 

Appendix 1: make sure that all the following fields are filled in: 

MSS Plants and Crops Composers 
o Test # 
o Application Method 
o Application rate 
o Number of Applications 
o Timing of Applications 
o PHI (Plants) /PBI (Crops) 
o Matrix 
o Citation 
o RLTM 
o Test Crop 
o Soil type 

MSS Livestock Composer 
o Test # 
o Gender 
o Dose route 
o Dose Measured 
o Matrix 
o Test duration 
o Citation 
o RLTM 
o Animal information 
o Dietary Regime 
o Dosing Regime 
o Sampling Information 

 

 

MSS Composer (Livestock) 

Appendix 1: information reported in the last fields is too long. 

 Review II. Materials and Methods > B. Study Design > Sampling > Table B.7.2.1-4. 
Sampling Collection information 

 Comply with the character limit and come down to 250 characters in column “Tissues 
Harvested and Analyzed” 
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Error message Solution 

 

MSS Composer (Plants, Rotational Crops) 

Appendix 1: information reported in the last fields is too long  

 Review II. Materials and Methods > A. Materials > 2. Test Crops > Table B.7.9.1. Crop 
Information 

 Comply with the character limit and come down to 250 characters in column “Crop/ 
Crop group”  

 

Too many characters in one field – the following error message will specify in which section 
it occurs. 

 

 

Appendix 2: missing structure (SMILES code) 
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Error message Solution 

 

Wrong ParamCode 

Check the information in section I. General Info, in particular if the Managers IDs 
information is correctly reported? 
Follow the procedure described in Annex I to add and/or modify the PARAM Code. 
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Annex 5 – From MSS Composers to MetaPath 

MetaPath 

MSS Plants (P) /Crops (C) /Livestock (L) Composer 

Type 

(P, C, 

L, All) 

Origin of the information displayed in MetaPath 

 

 

 

 

 

All 

Words which appear after the common name of the active substance come from 

fields : 

- “Crop/Crop group” of Table B.7.1.1-1. and Table B.7.9-1 (II. Materials 

and Methods, A. Materials, 2. Test Crops) of MSS Plants and Crops 

Composer, respectively 

- “Species” of Table B.7.2.1-1. (II. Materials and Methods, A. Materials, 2. 

Animals) of the MSS Livestock Composer 

 

To ease the search in MetaPath and immediately see the name of the studied 

species, it is important to fill in the MSS Composer as follows:  

- for plants: Crop/ Crop Group (ex: Wheat/ Cereals) 

- for rotational crops: Crop (rotation)/ Crop Group (ex: Wheat (rotation)/ 

Cereals) 

- for livestock: Species (ex: Goat) 

 

Please note that what comes after the slash does not appear in the MetaPath’s 

map directory 
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MetaPath 

MSS Plants (P) /Crops (C) /Livestock (L) Composer 

Type 

(P, C, 

L, All) 

Origin of the information displayed in MetaPath 

Function “Highlight Treatment groups”  

 

P 

Common fields : 

“Tomato/ Fruiting Vegetables”  II. Materials and Methods > A. Materials > 

2. Test Crops > Table B.7.1.1-1 Crop Information > Crop/ Crop Group 

“glasshouse”  II. Materials and Methods > A. Materials > 2. Test Crops > 

Test Site Type 

“Sandy loam”  II. Materials and Methods > A. Materials > 3. Soil Type > 

Table B.7.1.1-2 Soil Physicochemical Properties > Soil Type 

“6”  II. Materials and Methods > A. Materials > 3. Soil Type > Table B.7.1.1-

2 Soil Physicochemical Properties > pH 

“Tomato variety F1 Shirley”  II. Materials and Methods > A. Materials > 2. 

Test Crops > Table B.7.1.1-1 Crop Information > Variety 

“single dose”  TBD 

Coloring and specifics : 

“[ph_wheat forage_120DAA]”  V. Appendix > Appendix 1 > Test# 

“[phenyl-U-14C]-SYN545974”  V. Appendix > Appendix 1 > RTLM 

“Wheat forage”  V. Appendix > Appendix 1 > Matrix 
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MetaPath 

MSS Plants (P) /Crops (C) /Livestock (L) Composer 

Type 

(P, C, 

L, All) 

Origin of the information displayed in MetaPath 

Function “Highlight Treatment groups”  

 

C 

Common fields : 

“Wheat (rotation)/ Cereals grain”  II. Materials > A. Materials > 2. Test 

Crops > Table B.7.9-1 Crop Information > Crop/ Crop Group 

“outdoor test plots”  II. Materials > A. Materials > 2. Test Crops > Test Site 

Type 

“Sandy loam”  II. Materials > A. Materials > 3. Soil Type > Table B.7.9-2 

Soil Physicochemical Properties > Soil type 

“6”  II. Materials > A. Materials > 3. Soil Type > Table B.7.9-2 Soil 

Physicochemical Properties > pH 

“single dose”  TBD 

Coloring and specifics:  

“[ph_wheat forage_120DAA]”  V. Appendix > Appendix 1 > Test# 

“[phenyl-U-14C]-SYN545974”  V. Appendix > Appendix 1 > RTLM 

“Wheat forage”  V. Appendix > Appendix 1 > Matrix 

Function “Highlight Treatment groups”  
L 

Common fields : 

“Goat”  II. Materials and Methods > A. Materials > 2. Animals > Table 

B.7.2.2-1 General Test Animal Information > Species  

“female”  V. Appendix > Appendix 1 > Gender 

“in vivo”  TBD 

“Eggs”  TBD 

“entire liver […] carcass”  II. Materials and Methods > B. Study Design > 

Sampling > Table B.7.2.2-4 Sample Collection Information > Tissues 

Harvested and Analysed 

“Oral” V. Appendix > Appendix 1 > Dose route 

“single dose”  TBD 
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MetaPath 

MSS Plants (P) /Crops (C) /Livestock (L) Composer 

Type 

(P, C, 

L, All) 

Origin of the information displayed in MetaPath 

 

“Saanan”  II. Materials and Methods > A. Materials > 2. Animals > Table 

B.7.2.2-1 General Test Animal Information > Breed 

“7 days”  V. Appendix > Appendix 1 > Test Duration 

 

Coloring and specifics : 

“[Fat-ph]”  V. Appendix > Appendix 1 > Test# 

“[phenyl-U-14C]-SYN545974”  V. Appendix > Appendix 1 > RTLM 

“Fat”  V. Appendix > Appendix 1 > Matrix 
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MetaPath 

MSS Plants (P) /Crops (C) /Livestock (L) Composer 

Type 

(P, C, 

L, All) 

Origin of the information displayed in MetaPath 

Function “Search Chemicals” 

 

 

 

 

 

All 

Sedaxane (SYN524464): information comes from V. Appendix > Appendix 2 > 

Chemical Name 

 Please respect the following nomenclature so that the information appears 

clearly in MetaPath: common name (company experimental name) 

 

[Phenyl-U-14C]-sedaxane: information comes from II. Materials and Methods > 

A. Materials > Radiolabeled Test Material > name of radiolabelled test material 

“Radio-labeled #1” 

 Please respect the following nomenclature so that the information appears 

clearly in MetaPath: [radiolabelled group]-common name 
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MetaPath 

MSS Plants (P) /Crops (C) /Livestock (L) Composer 

Type 

(P, C, 

L, All) 

Origin of the information displayed in MetaPath 

     

All 

In the metabolic tree: 

The orange icon “EXJ” means that expertise on this metabolite is available. 

Click on the orange icon “EXJ” to have access to the information reported in the 

“Decision” field (V. Appendix > Appendix 2 > Expertise > Expertly 

specified > Decision) 

    

All 

In the metabolic tree: 

The green icon “CIT” means that the metabolite was assumed by author(s). It 

appears when “Assumed by author(s)” is ticked in V. Appendix > Appendix 2 

> Expertise > Expertly specified. You can click on the icon to have access to 

its meaning. 

    

All 

In the metabolic tree: 

The olive green icon “TE” means that the metabolite has a tolerance expression. 

It appears when “Tolerance Expression” is ticked in V. Appendix > Appendix 

2 > Expertise > Expertly specified. You can click on the icon to have access to 

its meaning. 



MSS Composer: v.1.12  

 

58 
 

MetaPath 

MSS Plants (P) /Crops (C) /Livestock (L) Composer 

Type 

(P, C, 

L, All) 

Origin of the information displayed in MetaPath 

    

All 

In the metabolic tree: 

The burgundy icon “RC” means that the metabolite is a residue of concern. It 

appears when “Residue of Concern” is ticked in V. Appendix > Appendix 2 > 

Expertise > Expertly specified. You can click on the icon to have access to its 

meaning. 

 


